Reviewing metrics in the CHaMP_Workbench: CHaMP QA 2016

Step 1: Getting Started:
1) Save the metric database zip file and unzip the database it to a known location on
your computer. (e.g. C:CHaMP_Workbench).

2) Open CHaMP Workbench. If using Windows 8 or higher, search for “CHaMP” on
your computer.

The software can be downloaded from: http://workbench.northarrowresearch.com/

3) The Workbench software will come with ~ ® CHaMP Workbench
a blank Access database. | File | Edit Data Tools Experimental About

Open Database...

The next step is to connect the Field Sea

Workbench software to an Access
database pre-loaded with 2016 CHaMP

Close Database

=¥  Create New Workbench Database.., | 2015
2015

metrics. i

[#l1 Open Database in Access... 2015
Open the File menu and select ‘Open Exit 2015
Database’. This will allow navigation to 2012 il Asotin 2015

the database that was stored in Step 1. 5 & e

Step 2: Reviewing Visit Status

Metric review is most efficient when all metrics for all field season visits are available so
that the charts can be reviewed in as few iterations as possible. Visits may not have
metrics because data have not been uploaded, metric engines have not run, or there
was an error during metric generation.

1) Ensure all Visits have all available data uploaded (refer to upload review process in
Part 1 of the 2016 QA process. Log an issue into JIRA to document remaining issues.

2) Review Visits without metric generation (RBT engine not run). Navigate to the Menu

and select Tools, then User queries and select ‘Review Visit RBT Status’. This will
prompt a .csv file to be downloaded and opened in Excel.
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http://workbench.northarrowresearch.com/
https://trackisemp.atlassian.net/issues/?filter=10501

(® CHzMP Workbench

File Edit Data | Tools ] Experimental About
& RBT 4 Stream
. Stte Stream
LIwp: [t §  Hobitat v L | Logger
Field Seasons B Det3D - ASWO0D01-SF-F... | South Fork Asoti...
(] 2016 " ASWOO0D01-SF-F... | South Forl Asoti...
% Model Validation Rep_orts... | » ASWODJ01-SFF_ | South Fork Ascti._
7 2013 . Generate Channel Unit CSV file(s)... ASWDOIOLSEE | South Fork Aot
(] 2012 ‘_’J User Queries 4 Manage Queries...
Wt & U;er‘Feedh.ack ' Review User Feedback-editable
- i Mt ferick: " | Review Visit RET Status
nam . = -
[] Region 17 a Options... Review Error Log Messages
[ South Fork Salmen | | Wenatchee | 2015 CBWO5583-0954 | Wie River

In Excel, review the Visits where the column “Null-RBTNotRunOnVisit’ is NULL. These
visits have not had RBT run yet. Contact Carol (carol@southforkresearch.org) to
discuss if these nulls are not expected.

These are also available in the Access database via query QA _VisitStatus_Errors.

3) Review Visits with Errors in RBT metric engine. The RBT metric engine produces a
list of errors when metrics are not successfully generated. Shortened versions of these
errors can be downloaded as a .csv file from the Tools/User Queries/Review Error Log
Messages.

(® CHaMP Workbench

File Edit Data | Tools Experimental  About
& RBT 4 Stream
; Site Stream
[]veiD 1 & Habitat g | _ Logger
Field Seasons Delft 3D <a | | ASWO0001-SF-F... | South Fork Asoti... |
[] 2016 o ASWO00001-SF-F... |South Fork Asoti...
E Model Validation Reports... » ASWODD0T-SF-F... | South Fork Ascti.
EZUT; Generate Channel Unit CSV file(s)... R \SWOODDISEE S Fork Asoft
[] 2012 |_+J User Queries 4 | Manage Queries...
i &8 User‘Feeleack é Review User Feedback-editable
T W Metnc feven. : Review Visit RBT Status
nam .
] Region 17 & Options... | Review Error Log Messages |

*Note that the .csv file sometimes has formatting issues where columns are shifted by
1-2 places. Use the Access review queries

Full error messages are stored for ALL runs of the Models in the Access table
LogMessages and can be reviewed using the query QA_ErrorMessages_6_final.
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Step 3: Visit Selection

Metrics can be reviewed by Program in the Workbench. A list of available metrics in the
database can be reviewed in Tools/User Queries “Review Available Visit Metrics”.

(® CHaMP Workbench
File Edit Data | Tools | Experimental About
i @ RBT > Strean
[ Site Stream
LT |1 & Habitat v b Logge
Field Seasons B Det30 , | _|ASWDO00O1-SFF.. | Souih Fork Asoi.. I
[] 2016 — | | ASWD0001-SF-F... | South Fork Asoti...
Z Model Validation Reports... r | ASWOOD01-SEF_ |S Fork Asoti |
% g:}; . Generate Channel Unit CSV file(s)... ASWO001-SEE | South Fork Asofi
(] 2012 |1 User Queries » Manage Queries... [
. S O Pk ' Review User Feedback-editable |
- B Mieiox e g Review Visit RBT Status
[ Region 17 & Options.. Review Error Log Messages
0 ?wth Fork Salmon Wenatchee |2015 Review Available Visit Metrics [
% g i Wenatchee 12015 |CBW05583-1010... | East Fork Mission...

1) Select visits for metric review. Use the year/watershed filters or select Visits

individually in the main visit inventory. Rows will be blue when selected. Hold the Shift
Key down to select multiple Visits.

(® CHaMP Workbench
File Edit Data Tools Experimental About
O ven [ 3 | Watersed Field Season Ste Strean ﬁxﬁm
Field Seasons i Wenatchee CBWO05583-0027... Chikamin Creek B
j 2016 ~ Wenatchee CBWD5583-0077... Nason Creek H
% Wenalchee CBWD5583-0954... White River =)
[]2013 Wenatchee CBWD5583-1010... East Fork Mission... B
[]2012 v Wenatchee CBWO5583-3284_ Peshastin Creek ]
Wenatchee CBWO05583-3309... Litle Wenatchee... 5]
.\; d . Wenatchee CBWD5583-3969... Kshler Creek [ ]
[] Big-NavamoGarcia (CA Wenatchee CBW05583.5153... Peshastin Creek [
(] Entiat Wenatchee LWINODO1-000001 m
% m{)&y Wenatchee LWINDDO1-000027 23]
[[] Methow Wenatchee LWINDOO1-000037 B
% m 17 Wenatchee LWINOOO1-000041 1]
[[] South Fork Salmon Wenatchee WC503432-0000... ' Tronsen Creek 2]
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2) Go to the Tools menu and select Metric Review / CHaMP (or another Program) to
open the Metric Reviewing window. This step takes a few minutes, so wait patiently.

(® CHaMP Workbench

File Edit Data | Tool_s—| Experimental About

& RBT » Stre
[Jweip. |1 |y Habitat b = e Log
Field Seasons B3 Delft3D . CBW05583-0027...

CBWOD5583-0077...
CBWO05583-0954...
CBWO05583-1010...
CBWO05583-3284...

Muodel Validation Reports... 3
Generate Channel Unit CSV file(s)...

User Queries »
User Feedback >
Metric Review...

Opticns...

Confederated Tribes (CTUIR)

Step 4: Metric QA/Review

Please Review the Appendix: Introduction to the Metric Review Window
Before Proceeding

1) Sort each metric in the metric grid and identify any visit with nulls. If an issue is
found with a metric or is missing then the source measurement data will need to be
located and reviewed.

a) Check the Measurement data on champmonitoring.org to ensure data exists.
If the spurious measurement should be resolved, see the Appendix for how to
update Measurement data on champmonitoring.org. If you are unsure why
the metric may be missing or incorrect, contact Carol@southforkresearch.org.

b) If the metric is derived from topographic data, open the survey geodatabase
in the CHaMP Toolbar (ArcMap), review the data and resolve the issue (if
possible) and re-upload to cm.org via the Data Check in Tab.

c) There are three options for how to proceed once a spurious measurement (or
metric) has been identified:

a) If the spurious value is not valid due to confirmed field collection
issue (operator error, equipment error, or not measured) then the
measurement value should be deleted and noted (add notes at
record level in champmonitoring.org and in User Notes in workbench.

b) If the spurious value looks suspicious but cannot be confirmed as
invalid and spurious value may be due to natural anomalies, note
that the anomaly was reviewed but not confirmed as invalid. These
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are suspect values at the record-level in champmonitoring.org and
the User Notes of the Workbnech. The values will remain within the
dataset.

c) If a spurious value is confirmed as a known natural anomaly (e.g. log
jam or restoration action contributing to high LWD frequencies) then
add note to measurement record(s) and the User Notes in the
Workbench.

2) Review preset Metric Plots
a) Review the first graph in the preset list of plots in “Plot Types'.
b) If a suspect metric value appears, find the Visit in the metric grid and review the
metrics more carefully.
c) Make a User Note* to document the QA status of the reviewed plot (see User
Notes section in Appendix for instructions).
a. A User Note should be made to rate each plot.
b. Follow the same anomaly review/note guidance as described for Metric
Grid review.
c. If the metric of concern on the plot can be identified, then add the Metric
Name (x or y axis label) to the description of the user note. These will be
compiled and added to champmonitoring.org at a later time.
d) Continue reviewing preset Plot Types, anomalies, and making notes until all
preset plots are done.

3) Independent review of metrics

Use the X axis and Y axis dropdowns in the metric plot window to do free form review of
metrics that are of interest or may have suspect values due to sampling or site
concerns. Follow guidance outlined in Metric Grid and Metric Plot sections to resolve
issues and make User Notes.

4) Once metric review is complete, we recommend making a User Note to list all Visits
that should have the metrics reviewed a second time. Send this list to
Carol@southforkresearch.org and when the updated data are available the new metrics
will be sent out for review.

A small number of metrics are not available for review in the CHaMP workbench at this
time.
a) Temperature metrics: can be reviewed on champmonitoring.org
b) GCD metrics: will be available for review later this winter (metrics are available
in the Workbench database but not accessible through the Workbench Metric
Review tools).
c) Tier 1, Tier 2, and Channel Unit metrics not displayed at the Visit Level (metrics
available in the Workbench database but not accessible through the Workbench
Metric Review tools).
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Step 5: Promoting Visits on champmonitoring.orqg

a. If data collected for the visit was for an AEM-specific or AEM+CHaMP Protocol,
the AEM QA Process and Protocol should be completed PRIOR to promoting a
visit.

b. From the Metric tab on the Site Details page, click “Promote Data”

c. From the Visit tab on the Watershed page, track progress using Visit Phase
column.

d. Promote all applicable visits within the watershed.

e. Note: We will not be setting the QA rating of tables in champmonitoring.org this
year. Relevant notes will be moved to the champmonitoring.org system as
needed.
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APPENDIX:

Introduction to the Metric Review Window

Before starting Metric QA, review the functionality of the Metric Review Window.

il CHaMP Metric Review (=] *
Pettpes |02 S Trabweg 520 Longtho Weed Ste Length - Dute (Wedneaday. Hovenber 8,201 - |
Kaes Wesed Sae Lengtn | Yaes | Thatweg Ste Length - User | }
Gty mtrg =
\nhetted Scie Length by Thalweg Site Length Y
Bemwviewed Pt Wetted Ste Length by Thatweg |
800— = Al Visits - !
= ® Vi 34 Waerhed Werstones -
. See [CHWOSSEI01098
600~
s - Vst | VistiD 3104 2015 by Ter c
b [ - "
3 400 b
200 .
| -
-
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1 1 I [} 1222504 ]
s %0 0812517 1 1 [ [ [ 12187578 044354 098815 1
306 15 54478 ' 1 0 [ 0 12365854 [ErT 105054 1
067 5 11745 8296 1 1 o [ 0 139 00127 osee2 2 1 | |
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There are 3 panels to the Metric Review Window, the (a) Metric Grid, (b) Plot and (c)

User Notes.

a) Metric Grid: This grid lists all program

metrics from all metric engines.

e The Visit selected in the
grid will appear as a red

dot on the graph.

e Metrics can be sorted by

clicking on the metric
name in the grid.

b) Metric Plots: The metric plot allows
graphing of available metrics in the
database.

02 Size:Thalweg Site Length to Wetted Site Length

03 Size: Wetted Site Length to Wetted Channel Total Length

04 Size: Bankdfull Area to Wetted Site Length

05 Size: Wetted Area to Bankfull Area

06 Size: Bankfull Width Avg to Wetted Area

07 Size: Wetted Area to Wetted Volume

08 Size: Wetted Volume to Banidull Volume

09 Widths: Integrated Wetted Width to Wetted Ste

10 Widths: Average Wetted Width to Integrated Wetted Width

11 Widths: Bankfull Width to Integrated Wetted Width

12 Widths: Average Bankfull Width to Integrated Bankfull Width

13 Shape: Wetted Width to Average Depth Ratio to Gradient

14 Shape: Bankfull Width Avg to Bankfull Width to Max Depth Ratio Avg

15 Shape: Gradient to Thalweg Depth Avg

16 Shape: Gradient to Sinuosity

17 Shape: Banidfull Width to Average Depth Ratio to Gradient

18 Shape: Detrended Blevation SD to Gradient

19 Shape: Gradient to Wetted Depth SD

20 Character: Bankfull Width Average to Discharge

21 Character: Conductivity to Alkalinity

22 Character: Discharge to Drift Biomass

30 Fish Cover: Wetted Area to Fish Cover: Total

31 Large Wood: Wetted Width Integrated to Large Wood Frequency Wetted
32 Large Wood: Large Wood Frequency Wetted to Large Wood Frequency Bankful
33 Banks: Wetted Area to Percent Undercut By Length

34 Riparian: Riparian Cover; No Canopy to Solar Access Summer Avg

40 Substrate: Substrate Est: Cobbles to Substrate Est: Coarse and Fine Gravel
41 Substrate: Substrate Est: Coarse and Fine Gravel to Substrate Est: Sand and Fines
42 Substrate: Substrate Est: Sand and Fines to Substrate: Embeddedness Ava
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e The Plot Type dropdown includes a list of preset metric graphs (44 plots).
The down arrow can be used to scroll through these without using the
dropdown.

e The X axis and Y axis dropdowns can be adjusted for free-form graphing

of any metric.

A square can be dragged and dropped over the graph to zoom in.

Bankiull \+widsh Sug by Wenied Area
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The small bullseye dot on each axis will zoom out (circled in red).
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c) User Notes. The workbench allows entry of notes and assignment of a data
guality rating of a plot. These notes are NOT currently compiled into
champmonitoring.org but might be in the future.

Notes are entered by filling in a “User”, “Quality rating”, and a “Description”. Notes
may be specific to a Visit, Site, or Watershed.

Pass: Data are within expectation for the plot/watershed/site or visit.

Does not Pass: Data are not within expectation for the plot/watershed/site or visit.
Suspect: Data are not within expectation for the plot/watershed/site or visit but there is
no known reason why data do not meet expectations.

Not Assessed: Plot not assessed.

Data Not Available: Data not available.

If a note specific to a site or visit was made and you need to ‘clear’ these values from
the notes window, switch the dropdown of Watershed to a watershed that’s not your
own and then switch back to the watershed of interest.

To review previously entered feedback, go to the Tools menu and select User
Feedback/All User Feedback for All Entries.

(® CHaMP Workbench

File Edit Data | Tools l Experimental  About
& RBT
L] vistiD |1 § Habitat
Field Seasons B Deit3D _CBW05533-0027...
[ 2016 CBWO05583-0077...
E Model Validation Reports... CBWOS583.0954.
[]204 Generate Channel Unit CSV file(s)...
[ 2013 CBWO5583-1010
] 2012 S User Queries el D
‘Q” User Feedback &’ Create New User Feedback ltem...
Watersheds il Metric Review... & UserFeedback For Selected Visits...
W] Asotin 5 . ) :
] g Navamo Garc a Options... & All User Feedback for All Entries...
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Updating Measurement Values on champmonitoring.org.
2) In the new browser tab, review the measurements that participate in the derive
metric value (see section 10 for description of mapping between measurements and

metrics)

[ visis |

This site's watershed is: Upper Grande Ronde

ts || Metrics || Tags Vist: UGR_Small_Streams-07/01/2013
Auxiliary Data H Site Photos H Topographic Data ” Solar Input H Air Temp H Stream Temp H QA Status _ o
| Measurement Type: | Discharge [«] I
Grid |[ Graph ][ QA Notes |
Currently viewing 17 of 17 discharge records B pownload

Data Update Notes

0.2 28 o
03 3am 0.04
02 24m 005 m
02 28m 015 m
02 93m
0z 0z23m
02 021 m
02 02 m
02 15 035 m
0z 17 028 m
02 15 028 m
02 12m 034 m
02 [RR 032 m am
0z 09am 0z2z2m 6 m
02 07 m 024 m 24m
02 0.5 017 m 5 m
0.1 0.2 om om

3) Update any spurious measurements. If the measurement data is correct,
leave data alone. If the anomaly is prominent, it is worthwhile making a note
of it in the QA Status notes OR in the Data Update Notes column of the

Measurement table.
m Graph || QA Notes

Currentty viewing 17 of 17 discharge records

B pownload

1 0.2 ] om
1 0.3 33m 0.04m
1 0.2 aim 0.05m
1 0.2 Z8m 01Em
1 0.2 7m 0.zm
1 0.2 .6 m 022m
1 0.2 z3am 021 m
1 0.2 Z1m 021 m
1 0.2 1.9m 025m
1 02m 1.7m 026m
1 0.2 1.5m 028m
1 02m 1.2m 024m
1 0.2 1.1 0.zzm
1 0.2 08 m 022

1 0.2 0.7 m 024
1 0.2 05 m 017
1 0.1 0.3 om 0 0

(e==m)

4) Be sure to Save Changes before moving to a different table or leaving the page.
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